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WARNING!

Programmable control devices such as the Touch PRLS must not be used as stand-alone protection in any
application. Unless proper safeguards are used, unwanted start-ups could result in equipment damage or
personal injury. The operator must be made aware of this hazard and appropriate precautions must be taken.

In addition, consideration must be given to the use of an emergency stop function that is independent of the
programmable controller.

The diagrams and examples in this user manual are included for illustrative purposes only. The manufacturer
cannot assume responsibility or liability for actual use based on the diagrams and examples.

WARNING: If the Touch PRLS is used in a CLASS I, DIV. 2 environment, the following conditions must be met:
Class I, Div. 2 methods; AND — must conform to all rules and requirements of applicable jurisdictions regarding
Class I, Div. 2 installations; ALSO — peripheral equipment controlling this device or being controlled by it shall
be suitable for service in the location in which they are used. Failure to comply with any of the above
installation requirements will invalidate the device’s qualifications for service in CLASS |, DIV. 2
hazardous locations.

WARNING: EXPLOSION HAZARD — SUBSTITUTION OF COMPONENTS MAY IMPAIR SUITABILITY FOR
CLASS |, DIVISION 2.

WARNING: EXPLOSION HAZARD — DO NOT DISCONNECT EQUIPMENT UNLESS POWER HAS BEEN
SWITCHED OFF OR THE AREA IS KNOWN TO BE NON-HAZARDOUS.

CAUTION
Do not press the Touch PRLS touchscreen with any sharp objects. This practice may damage the unit beyond
repair.

Trademarks
This publication may contain references to products produced and/or offered by other companies. The
product and company names may be trademarked and are the sole property of their respective owners.
UTICOR Technology, L. P. disclaims any proprietary interest in the marks and names of others.

© Copyright 2003, UTICOR Technology, L.P.
All Rights Reserved

No part of this manual shall be copied, reproduced, or transmitted in any way without the prior written
consent of UTICOR Technology, L.P. UTICOR Technology, L.P. retains the exclusive rights to all information
included in this document.
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Touch PRLS™

The Touch Programmable Resolver Limit Switch (PRLS) is essentially a Pow-
erPanel with two Option Cards installed in the unit (PRLS card and Output
card). There are special connectors on the cards that are accessible from the
bottom of the unit that allow communication with a resolver. This supplemental
manual provides you with information particular to the Touch PRLS and will be
used to supplement information provided in the G2 Series PowerPanel Hard-
ware Manual (MAN-UTICW-001) that was also shipped with your Touch PRLS.

You will configure the Touch PRLS using the Touch PRLS Programming Soft-
ware and PowerPanel Programming Software, Version 4.0 or later.

These manuals will take you through the steps necessary to get your Touch
PRLS up and running in the shortest possible time. Although your familiarity
with programmable graphic operator interface devices will determine how quickly
you move through the steps — itsaseasyas 1 —2 — 3.

Touch PRLS Programming Software is a user-friendly Windows-based pro-
gram that allows you to program the Touch PRLS. Touch PRLS Programming
Software is an executable file (Touch_PRLS.exe) that can be found in the Pow-
erPanel Programming Software Program folder (this is installed by default to:
C:\Program Files\PowerPanel\) that was created when you installed the soft-
ware on your programming computer. For more information, please refer to
the PowerPanel Programming Software User Manual.

The G2 Series PowerPanel Hardware Manual will provide you with the instruc-
tions you need to install the panel. Included are mounting diagrams for Stud
Mounting, Connections and Wiring requirements, Panel Setup instructions,
Maintenance, and Troubleshooting. For installation information particular to
the Touch PRLS Panel, see the Touch PRLS Hardware Manual (MAN-TPRLS-
001).

The Touch PRLS Programming Software allows you to program the PRLS
card in your panel. UTICOR has provided a PRLS Demo Program with the
PowerPanel Programming Software that can serve as a model or be modified
for use in your motion control application. Use Touch PRLS Programming
Software to program the PRLS card and then use the PowerPanel Program-
ming Software to create screens for the Touch PRLS panel that provide a graphi-
cal interface designed to interchange and display data from a machine-based
resolver by merely viewing or touching the screen — all unique to your par-
ticular application. For instructions on how to design these screens, refer to
the PowerPanel Programming Software User Manual.



Touch PRLS™ UTICOR

What you need to get started:

You will need the following hardware and software to configure a Touch PRLS
System. A PLC does not have to be connected to configure the Touch PRLS

Hardware

* Touch PRLS Series (6", 8", 10", or 15" Color unit)

* 24 \olt Power Supply

* RS-232C Programming Cable (P/N CBL-UTICW-009)

* TPRLS to Resolver Cables: CBL-TPRLS-005 (5 ft.), CBL-TPRLS-
010 (10 ft.), CBL-TPRLS-015 (15 ft.), or CBL-TPRLS-020 (20 ft.)

* Resolver, such as AVG’s RL100, E5R, E7R, or E8R Series

* TPRLS I/O D-sub Cable (P/N CBL-TPRLS-I/O3)

* PLC and PLC Cable (see PowerPanel Hardware Manual)

* PC requirements:
— |IBM or compatible PC (486 or better) with a mouse, keyboard
and separate serial port
— VGA display with at least 800 x 600 resolution (1024 x 768
recommended)

— Standard Windows 98/NT4.0/ME/2000/XP® Requirements
— CD ROM Drive

Software
* PowerPanel Programming Software, Version 4.0 or higher

* Touch PRLS Programming Software (P/N ACC-TPRLS-EDIT)
(included on CD that was shipped with the TouchPRLS)

Need HELP?

@ Help is never more than a mouse click or a key press away!

Onscreen HELP

One of the most important features of the Touch PRLS Programming Software
is the availability of context sensitive onscreen help. To access the Help win-
dows, simply press the F1 function key while on the topic where you need
help. For example, if you need help while working with screens, hit the F1
function key while in that area and a popup window will be displayed. Also,
most dialog boxes contain a Help button, you may click on it to get help, too!

2 MAN-TPRLS-002
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Fly-Over HELP

When the mouse cursor comes to rest over any tool bar or object button for a
short while, a small window will appear containing a brief description of the
function of that particular button. The window will disappear as soon as the
cursor has been moved off the button.

Technical Support

Although most questions can be answered with Touch PRLS Programming
Software HELP topics or the manuals, if you are still having difficulty with a
particular aspect of installation or configuration, technical support is available
at 1-800-TEC-ENGR (832-3647) or FAX us at 1-563-359-9094. Visit our
website at www.uticor.net.
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Overview of Touch PRLS Functions

The Touch PRLS (PRLS = Programmable Resolver Limit Switch) uses a re-
solver as a position transducer. Unlike incremental encoders, the resolver, along
with its noise-immune ratiometric converter, always gives true machine posi-
tion, even if the machine has moved during a power outage. An AVG resolver
is constructed to be rugged and reliable, even in temperature and humidity
extremes, and under prolonged exposure to mechanical shock and vibration.

Touch PRLS Programming Software makes it easy to configure your applica-
tion. Using a Windows-based architecture and lots of popup screens with pull-
down selections, you should be able to quickly build and configure your project

The Touch PRLS brings operator-friendly touch screen control of the PLS to
your application, and offers you the MOST ADVANCED PLS features. The
features are described below:

+ Leading and Trailing Edge Speed Compensation
The Touch PRLS features Leading and Trailing Edge Speed
Compensation (Rate Offset) to compensate for speed variations.
The Rate Offset, individually programmable for each channel, is
used to advance the PLS settings as a function of the machine
speed.

*  Pulse Programming
Touch PRLS can be fine-tuned while your machine is running.
Either or both of the ON and OFF Setpoints can be incremented or
decremented.

*+ Angle ON/ Time OFF
The Touch PRLS can be programmed to have its outputs turned ON
at an angle and turned OFF after a programmed time by touching
the screen. For example, channel 8 can be turned ON at an angle
of 100° and stay ON for a period of 2.45 seconds.

*+  Programmable ModZ Functionality
The Touch PRLS features a dynamic zeroing or ModZ (Modification
Zero) to modify the zero reference point independent of the actual
resolver position. After the PLS receives the ModZ input, the
resolver position is reset to zero. This PLS can be field
programmed to ModZ

4 MAN-TPRLS-002
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* Flexible Channel Assignment
When it is desirable to control several different machines linked to
the same drive shaft, the TPRLS’s Flexible Channel Assignment can
be a powerful and useful feature. Output Channels 1 through 31
may be defined as PLS or ModZ type. Each ModZ Channel can
have has its own ModZ Inhibit Zone.(Channel 32 is PLS only.)

¢ Speed Switch (Built-in Motion Detector and Tach)
The Touch PRLS has a built-in Tachometer and Motion Detector. In
the Tach Mode, the TPRLS displays the machine shaft speed in
RPM. The Motion Detector energizes a relay when the RPM is
between the programmed Low and High Limits.

* Password Protection
The Touch PRLS has a Password Protection feature eight-levels
deep. Up to eight different passwords (user programmable from the
touchscreen) allow access to different screens in the Touch PRLS,
providing ultimate protection and security of machine settings. You
can program this in the PowerPanel Programming Software project.

Touch PRLS as a Stand-alone Product or as a Part of a Con-
trol System.

Used as a stand-alone product, the Touch PRLS can use the Touch PRLS
Programming Software to directly configure the TPRLS Card in the panel.

Simply connect the programming computer, resolver and power leads, turn it
on, and program the setup for your PLS. You can go online to directly monitor
the PLS. If this is all your application demands, follow the instructions to config-
ure your PLS and you’re ready to run.

Then you use the PRLS Demo Project included with the PowerPanel Program-
ming Software Version 4.0 or higher. This Demo program provides all of the
screens essential to setup, monitor, and change settings in your PLS. Each
screen consists of displayed text and graphics, plus pushbuttons, all imple-
mented for quick operator access directly on the configurable touchscreen.

When you need more than a simple stand-alone application, integrating
the Touch PRLS with a PLC offers almost limitless possibilities. Touch PRLS’s
PowerPanel touchscreen operator interface is fully ready to integrate the power
of a PLS and a PLC into a seamless system, bringing the ease of touchscreen
control to your machinery in the simplest manner yet devised.
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Because the operator interface uses two processors, one for the PLS opera-
tion, and the other to manage, display, and communicate with the PLC, the
Touch PRLS can share PLS information with the PLC, while displaying the
data from both on a single screen. Printers and a marquee can also be con-
nected and configured with the Touch PRLS. Many models of PLCs can be
accommodated by the Touch PRLS'’s library of drivers and new drivers are
continually being added.

Easy, Economical, Flexible

More than just a touchscreen-based replacement for hard-wired switches, pi-
lot lights, LEDs, etc., the Touch PRLS can accommodate changing production
requirements, often in minutes, with its advanced graphical operator interface—
and you can make these changes online or offline

The Ol part of the Touch PRLS offers you functionality that is not possible with
discrete operator panels. It's not only an economical replacement for common
hard-wired panel components, such as pushbuttons, pilot lights, and selector
switches, it also provides complete flexibility—with the Touch PRLS, your panel
is never obsolete! Additionally, panels based on Touch PRLS can be made far
less cluttered by displaying only the necessary controls, thereby reducing pos-
sible operator confusion.

The PowerPanel touchscreen used in the Touch PRLS has been designed to
interchange and display graphical data from a programmable limit switch (PLS)
by merely touching the screen.
The Touch PRLS is available in four display types designed to suit any appli-
cation and budget. Any of these display types may be ordered with eight or 16
outputs and N-Type or P-Type output polarity. All other features remain the
same, except for the size and availability of colors on the screen. The four
display types are listed below:

. 6" STN Color

. 8" TFT Color

. 10" TFT Color

. 15" TFT Color

6 MAN-TPRLS-002
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Principle of Operation

The Touch PRLS, as shown in the block diagram below, uses two processors,
one for the PLS and the other to manage, display and communicate to the
PLC, if used. The PLS processor reads its position signals from the resolver
mounted on the machine shaft. It controls position-based outputs independent
of the interface processor, providing fast repeatable outputs. There are pre-
defined registers available for mapping the PLS. The PLS processor and the
interface processor share information through a-shared memory. The dynamic
information, such as position, RPM, and output status, is available to the inter-
face processor for display through registers. See Appendix A for more de-
tailed information about the registers.

-
Resolver RDC Touch PRLS Output “—
Processor Drivers
E T S s annpup-
T 1 Inside the
Shared Touch
LCD Display Memory PRLS
Operator PLC
Ve / Interface || o0
o Processor
96 Cell Touchscreen A 4
v
Programming Programmable
Cﬂmputer | sssnssssnsnnnnnnnnnnnnnnnnnnnnnnn L LOgic
Controller (PLC)
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Touch PRLS Total Integration

The traditional way to communicate your machine position, speed, or PLS sta-
tus to a PLC network, was through hard-wired discrete outputs. As far as the
PLS program settings were concerned, they were simply not available to the
PLC. The Touch PRLS can communicate to many different PLCs through a
serial connection. PLS status can also be fed to the PLC through the same
bus connection. Hard PLS outputs are available to activate machine solenoids

directly.
Marquee |7
Programmable
Logic
Controller (PLC))
Touch
Programming |. . - - J NPRLS :
Computer ( | o ___ JI
Printer

I: R

PLS Output

System Configuration

The system, or “global” parameters,” will be set for each PRLS Project under
the menu items, Project Information, System Attributes, and Communica-
tion Setup in the PRLS Programming Software.

All programs created under a single project will share the parameters config-
ured under these menu items.

Project Information includes: Plant, Machine, Job, and Comments. This in-
formation allows you to categorize, describe, and reference the project. You
may also enter information in the Comments field that may be needed by pro-
grammers for future revisions to the project.

System Attributes include:
Machine Offset

This is the number of increments by which the indicated zero position will differ
from the resolver’s actual zero position.

8 MAN-TPRLS-002
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Scale Factor
This is the number of increments that one turn of the resolver will be divided
into.

Direction
This refers to the direction that the resolver revolves, Clockwise or Counter-
clockwise.

Modification to Zero (ModZ)

Under this tab you will set the ModZ Scale Counts for ModZ (Input 1), ModZ
(Input2), and ModZ (Input 3). Modification to Zero (ModZ), or dynamic zero-
ing, enables you to modify the zero reference pointindependent of the resolver’s
actual position.

When a False-to-True transition is detected on the ModZ Input, the current
angle of the resolver becomes the new reference “0” point and all setpoints for
the Channels assigned to that input mode are then referenced to this value.
The ModZ Cycle terminates when one full resolver revolution is made. To start
a new ModZ Cycle, the ModZ Input must make a new False-to-True transition.
If programmed, the IGNORE MODZ FOR (xxx) Scale Count is the number of
Resolver counts that must occur from the start of a ModZ cycle until the next
ModZ cycle is initiated. Once a ModZ cycle is initiated, any transitions of the
ModZ input will be ignored until this programmed value is exceeded.

Next you will program Channels 1 through 31* as either ModZ (to be triggered
by Input 1, Input 2, or Input 3) or to remain as a PLS. If you do not select a
Channel as ModZ, it will function as a normal PLS Channel. If selected as a
ModZ Channel, it is controlled by the corresponding ModZ Input.

Debounce Inputs

This lets you select whether or not Input 1, Input 2, Input 3 (all ModZ) or Input
4 (Program Enable) are fast or normal debounce. When selected, false read-
ings created by fast debounce will be ignored. If not selected the inputs will be
read as “normal” debounce.

Communication Setup
Under Communications setup you will define the parameters that allow com-
munication between the Touch PRLS and programming PC.

Program Configuration

Within each project, you can have several programs. Programs (also called
“Job Setups”) contain all of the parameters, commands, etc., necessary to
perform the requirements of a particular application. Up to 32 channels or out-
puts can be controlled by a single program.
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10

The PRLS Project may contain many distinct programs (only limited by memory)
and can implement each as needed—but, only one Program may be active
at a time.

Once a program is stored in the PRLS, unless there’s a change or deletion, the
program never needs to be entered again.

Channels

Channels 1 through 31 may be defined either as a ModZ or PLS type —Chan-
nel 32 is PLS type only. This creates the effect of 32 independent PLS’s run-
ning from the same resolver. This can be a very powerful and useful feature
when it is desirable to control several different types of processes all being
driven by a common shaft. Each ModZ Channel has its own input and a ModZ
Inhibit Zone (more on ModZ Inhibit Zones later).

There are 32 independent output channels, each of which contains its own
setpoints (used to turn the output ON or OFF at specific shaft angles). Chan-
nels 1 through 16 also contain their own speed compensation factor (so that
the response time of field devices, such as relays/solenoids, may be compen-
sated.)

Speed Compensation

Speed Compensation allows you to dynamically advance or retard a program-
mable output based on a resolver speed. This is useful for compensating field
device response time. Speed Compensation can be added to a set point to
adjust time. You must make sure that you do not enter Speed Compensation
values whose ON/OFF times will overlap at Maximum RPM. Channels 1 though
16 have their own leading-edge and trailing-edge speed compensation.

Modification to Zero (ModZ)

Modification to Zero (ModZ), or dynamic zeroing, enables the user to modify
the zero reference point independent of the resolver’s actual position.

If you do not select a Channel as ModZ, it will function as a normal PLS Chan-
nel. If selected as a ModZ Channel, it is controlled by the corresponding
ModZ Input.

When a False-to-True transition is detected on the ModZ Input, the current
angle of the resolver becomes the new reference “0” point and all setpoints for
the Channels assigned to that input mode are then referenced to this value.

The ModZ Cycle terminates when one full resolver revolution is made.

Selection of Setpoints is crucial. Setpoints crossing “0” may give undesirable

MAN-TPRLS-002
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results when programmed into a ModZ Output Channel because PRLS will
react as if two Setpoints were programmed—one beginning at Zero and the
other ending at Zero.

When programming ModZ Setpoints and Speed Compensation Values into a
PRLS Channel, too much Speed Compensation could cause a similar Setpoint
split, or even cause a Beginning of Cycle Setpoint to occur at the end of the
Cycle. To start a new ModZ Cycle, the ModZ Input must make a new False-to-
True transition.

ModZ Inhibit Zone

If the Channel is ModZ, the System Attributes Offset is not used. Instead, there
is a parameter called the “Inhibit Zone.” The ModZ Inhibit Zone is an angular
zone in which the ModZ cycle may not be triggered. The Inhibit Zone begins
when the ModZ cycle is originally triggered (angle = 0), and continues up to a
preprogrammed angle. Once the ModZ cycle has progressed beyond this In-
hibit Zone, the ModZ cycle may be restarted by retriggering the ModZ Input.
Make sure that if a Channel uses ModZ that you do not add Speed Compensa-
tion value that will adjust the ON setpoint to a value less than zero (0). This will
cause problems with your resolver readings.

Supervisor Protection

The following functions are protected by checking for no Motion (position is
NOT moving) and by checking that the Program Enable input is active.

WRITE A VALUE FOR MACHINE ZERO

CHANGE DIRECTION

ZERO MACHINE

CHANGE MODZ INPUT FOR A CHANNEL

EDIT PROGRAM

UPDATE A SETPOINT

EDIT ON SETPOINT

EDIT OFF SETPOINT

PROGRAM USER MEMORY

AUTOZERO

The following functions are protected by checking that the Program Enable
input is active.

CHANGE SPEED COMP ON
CHANGE SPEED COMP OFF
CHANGE MODZ DELAY COUNT
FINETUNE INCREMENT
FINETUNE DECREMENT

11
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Error Messages

Error Number

Error Message

101

102

103

104

108

109

110

112

113

114

115

116

OFFSET OUT OF RANGE
Offset entered is greater than Scale Factor.

PAST LAST SETPOINT
Specified a setpoint number greater then the last valid
setpoint number.

INVALID SETPOINT VALUE
Value is invalid for this setpoint.

INVALID CHANNEL NUMBER
Specified channel does not exist.

USER PROG NOT FOUND
Specified user program number was not found.

INVALID TYPE OF SETPOINT TO FINETUNE
Can only finetune ANGLE ON/ANGLE OFF type of setpoints.

NO FINETUNE COMMAND SPECIFIED
The FINETUNE registers does not contains a valid value.

FUNCTION IS PROTECTED
Program Enable needs to be active for this function to work.

INVALID SPEED VALUE
The value for a SPEED SWITCH type of setpoint is invalid.
The maximum value is 1023 RPMs.

INVALID SETPOINT OFF TIME
The OFF time of an angle on/time off setpoint needs to be
between 0 and 4095 Msec.

SETPOINT TO FINETUNE NOT ON THIS CHANNEL
The specified setpoint number was not found the specified
channel number.

CAN NOT ADD A SPEED COMP

Only channels that already have a speed comp value can
be changed from the panel. If the ON and OFF values were
programmed with 0 you will need to change the speed comp
values from the Program Loader.

MAN-TPRLS-002
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118

119

120

121

122

200

Touch PRLS™

INVALID_MODZ_INPUT_NUMBER
The valid MODZ inputs numbers are 1, 2, or 3.

SETPOINTS_HAVE_MOVED_RESELECT_SETPOINTS
The setpoint numbers have been sorted and have changed
order. Please select the correct setpoint number.

INVALID_SETPOINT_NUMBER
The specified setpoint number was not found.

ABOVE MAXIMUM RPM
The RPM is above the supported range. Speed comp will
only function correctly up to 1023 RPMs.

FUNCTION NOT ALLOWED DURING MOTION
This function is not allowed while the RPMs are greater
than 3.

INVALID SETPOINT TYPE FOR MODZ
A setpoint for the selected channel does not support a MODZ
input.

BROKEN WIRE
This indicates that a resolver wire is broken.

13
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Main Programming Screen
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The Main Programming Screen is shown above. It is here that you will config-
ure your Touch PRLS system. In this section, we’ll briefly identify and describe
the main features of this screen and familiarize you with the Touch NPRLS
Programming Software work area.

Title Bar

The Title Bar tells you the name of the project that you currently have open.

File Wiew Setup TouchPRLS ©Online  Uklities Help

Main Menu Bar

This is the Main Menu Bar. Touch PRLS Programming Software menus are
represented by the names listed across the top of the Main Programming Screen
and directly under the Title Bar. Each menu item is discussed in detail in the
Reference Section of this manual beginning on page 29.

15
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Toolbar

The Standard Tool Bar consists of icons for frequently used commands.
These commands are also found in, and accessible from, the Main Menu

Bar.

From left to right as placed on the tool bar, the icons and their functions are

shown below.

3 [ B0 §, O

.
4
o

ﬂ.‘!

o|X e X m

e e
E B |

7

Open New Project

Open Existing Project
Save Project

Print the active document

Display program information, version number, and
copyright

Transfers current project to Touch PRLS

Reads project loaded on Touch PRLS and transfers it
into a new project

Provides information on the Touch PRLS panel
Clears the Touch PRLS memory

Sets the machine offset to zero

Reads the input and output status of the Touch PRLS

Turns ON or OFF the display of the set point values in the
graphical display part of the main programming screen
Exports the current project’s set point values to
Excel format

Exports the current project’s set point values to
CSV format

Imports set point values in an Excel file format into the
current (open) project

MAN-TPRLS-002
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. Ei Imports set point values in CSV file format into the
current (open) project.

Programs List

This window lists the programs that have been configured in a single project.
Program Number and Name are listed as well as the Scale Factor (1 to 4096)
and Description for the program. You will click on the Add button to configure
a new program.

Prog # I Mame I Scale Factar | Dezcription
1 Test Program 1 360

Add Delete

Setpoints for Program List

This window lists the Setpoints that have been configured for a particular pro-
gram (highlighted in the list above). An Index # (for reference), Channel #,
Type (data type), and On/Off Setpoints are provided for each setpoint config-
ured in the program. To add a setpoint, click on the Add button at the bottom of
the list.

r— SetPoints for Program . (Total # of Setpoints: 0)

Indes# | Channel# | Type [ on T o

Add [elete

17
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Ready

Coler Captions: [ Angi=ott Il Timeoft M veocity  Scale Factor: 380

Channel SetF nints for Frogram : Frogram & 5
T 55 g2 110 138 155 193 221 248 276 304 331 359

crareit [ NN W W NN NN BN N

(Angle Off 1 g2 o4 122 164 108 245 299

crannei2 [

(Time 210 52 MSec

Chanmel 2 L

Spead Switch) 24RFM

Channel 4 | ]

(Angle OFfy o4

cranneis [ NN W W

(Angle Off) a2 94 128

crarnetes [ I

(Angle O 52

Channel 7
tAngle O e

Channel 8
(Angle Off a4

Channel 9
(Angle O 209

Channel 10
(Angle Off

r =1
& @
o
w

Channel 11
(Angle Off 52

Channel 12
(Angle O

Graphical Display Window

The window above displays the setpoint values in a bar graph format for the
selected program. A color coded (key provided at the top of the window) bar
graph allows you to easily determine the data type and set point values for
each programmed Channel setpoint in a program. Use the scroll bars to see
data that extends beyond range of window.

Project size: 142 bytes  (Max 125952 bytes) MUM A

18

Status Bar

The status bar provides you with the status of the program loader, and Project
Size, and how much memory you have left to use (Maximum bytes).

MAN-TPRLS-002
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Create a Project
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Make Connections
Connect the panel to your programming computer. Make any other device
connections in accordance with the Touch PRLS Hardware Manual (MAN-

TPRLS-001).

Install Programming Software
If you don’t have PowerPanel Programming Software (4.0 or later) installed on
your PC, do so now. Install Touch PRLS Programming Software (P/N ACC-
TPRLS-EDIT) on your system. Once you have the PowerPanel and Touch
PRLS Software loaded, click on their respective icons on your desktop to launch

the programs.

Touch PRLS™

Create an TPRLS Project in PowerPanel Programming

Software

1.  Open the PowerPanel Programming Software to create a TPRLS

Project.

2. The following Project Information screen is the first to appear.

Step 1: Project Information

[ SELECT ACTION —

H's ar easy as 1-2-3...

Selected Action : Edit Offline Write Later
~ENTER FROJECT INFORMATION

PowerPanel™

PawerPanel Programming Software Yersion 4.0
UTICOR Technology, L P: Phone 1-563-353-7501
s, Utico, et

Project Location :
Eg';im%a[\%me IE.\Fluglam Files\FowerFanelsProject Browse
to Panel Later) Praject Mame :
TPRLS Project.prp A
r Start Editing Screen
Read Program MNurnby 1 vI M. Scor 1 %
from Panel and e o I J
Edit OFF-LINE =
Panel Type G2 10" Color 640x480 &l e
r~First PLC
PLC Type i
e I TPALS -Rev A j “Wiew/Edit PLC Com Setup
Edit Program .
- ThitikenDio
ON-LIME i h I Erowse.
T Second PLC
- Ethermet/COM Port— PLE Tupe  [Modicon Modbus RTU -Rev £ 7] iew/Edit PLE Com Setun
and Frotocol
e ThiftterDo
ohfiguratio. Hap file I Browse...
= ] == |
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Enter a Project Name for your TPRLS Project. You can skip the Start
Editing Screen Number and Name fields at this time and enter the
information later.

PLEASE NOTE: A sample project has been included with the
Touch PRLS Programming Software. The project will be called
Demo_TPRLS and is in the Projects folder. A lot of the work has
been done for you in this demo program. You can modify it to
use with your application or just use it as a learning tool.

Select the Panel Type of your Touch PRLS. You will choose the G*2
Model that is the same size as your Touch PRLS.

Under First PLC you will select the TPRLS driver by clicking on the
down arrow to view the drop down list for PLC Type and Protocol.
Select TPRLS - Rev A.

The TPRLS Communication Setup is done automatically, so you
won’t need to click on the View/Edit PLC Com Setup... button. (If
you do, you will receive a message telling you that the software has
already done this.)

Next you may select the PLC you are using under Second PLC.
Those PLC types and protocols that will not work with the TPRLS are
not listed.

Click on OK to save the project. You may also click or Clear to begin
again or Exit to quit. without saving the project.

MAN-TPRLS-002
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Create a TPRLS Project in Touch PRLS Programming Soft-
ware

Now you are ready to begin configuring the TPRLS System Project.

1. Navigate to the PowerPanel Program folder that was create on your
computer when you installed the software. Find the TPRLS.exe file.
Double click on it to launch TPRLS Programming Software. The
following Main Programming Screen will appear.

iBi

Fle View Setup TouchPRLS Online Lkiities Help

DEEE[7 %% B x % 0Klal k|

0
color capions: [l snge ot Ml mimeon M velochy  ScalsFacior 580
Prog# | Name [ Scale Factor [ Description

Chamnal SetF oirms for Frogram st
e 10z 138 {70 204 Ja 272 o M

Channal 1
(Angle Of)

Channel 2
(Angle Of)

Channel 3
(Angle Of)

Channel 4
(Angle Of)

Channel 5
(Angle Of)

Add Delete

Channel &
(Angle Of)

Chanmal 7
Indes# | Chanel# | Tope [On [ o I (Angl= Off)

Channel =
(Angle Of)

Channel o
(Angla Of)

Chamnal 10
(Angle Of)

Chamnal 11
(Angle Of)

Chamnel 12
(Angle Off)

Chamnel 13
(Angle Off)

Chamnel 14
(Angle Off)

PReady [Project size: 108 bytes  (Max 125952 bytes) oM [ A

2. Begin by entering information about the project, click on the Main
Menu item Setup > Project Information. The following screen will
appear.

21
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Project Information x|

Plant

|
Machine I
Job I

|
|
Cancel

Comments

Enter the Plant name or other identification for the location of the
project. You may enter a name of up to 32 characters.

Enter the Machine name or other identification for the particular
device (resolver, encoder, limit switch) for which the project is being
created. You may enter up to 32 characters in this field.

Enter the name of the Job. Enter a name for the job name and/or
number that the device is to use, both for operation and editing. You
may enter up to 31 characters in this field.

Afield is provided for the programmer to enter Comments for
reference by operators or notes for programmers who may make
future edits to the project. You may enter up to 120 characters in this
field.

Next enter the project’s system attributes, click on the Main Menu
ltem Setup > System Attributes. The following screen will appear.

system Attributes x|

Gereral | ModZ I Diebounce Inpulsl

Machine Offsat g Scale Factor 20

Direction
’V % Clockwise ™ Counterclockwise

Ok I Cancel Help

MAN-TPRLS-002
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@Important Note:

Please be aware that
the Touch PRLS will not
function if the position
counts are descending.
The resolver position
must be ascending for
it to function.

MAN-TPRLS-002
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Under the General tab, enter the following resolver parameters:

a. Enter the Machine Offset. This is the number of increments by
which the indicated zero position will differ from the resolver’s
actual zero position. Enter a number between 0 and the selected
scale factor (maximum).

b. Enter the Scale Factor. Enter a number between 0 and 4096.

c. Enter the Direction of the resolver. Select either Clockwise or
Counterclockwise.

Under the ModZ tab, you will enter the Modification to Zero (ModZ), or
dynamic zeroing, parameter. ModZ enables you to modify the zero
reference point independent of the resolver’s actual position.

CETTTTES— «
General  ModZ |Dehﬂuncelnpuls|

Ignore Modz 1) for |0 scale counts  Ignore Mod? (3] for IU scale counts
lghore Mod?Z 2] for (O scale counts

Chi 1 IPLS j Ch# 8 IpLS j DhuWIPLS j Chit 25 IF‘LS ﬂ
Ch#2 IpLS j Ch#10 IpLB j EhtHEIpLS j Chit 26 IpLS j
Ch# 3 IpLS j Ch# 11 IpLB j EhtHSIpLS j Chit 27 IpLS j
Ch# 4 IpLS j Ch# 12 IpLB j Chit ZUIPLS j Chit 28 IpLS j
Chi 5 IPLS j Ch#13 IpLS j Chit 21 IPLS j Chit 29 IF‘LS ﬂ
Ch# & IpLS j Chit 14 IpLB j Chitt 22|PLS j Chit 30 IpLS j
Ch#7 IpLS j Ch# 15 IpLB j Chit 23|PLS j Chit 31 IpLS j
Ch# g IPLS j Ch# 16 IpLS j Chit 24|PLS j Chit 32 IFLS j

(1] I Cancel | Help |

a. The Ignore ModZ parameter is an angular zone in which the ModZ
cycle may not be triggered. This zone begins when the ModZ cycle
is originally triggered (angle = 0), and continues up to a
preprogrammed angle. Once the ModZ cycle has progressed
beyond this “ignore” zone, the ModZ cycle may be restarted by
retriggering the ModZ Input. Enter a value between 0 and scale
factor (maximum) scale counts for ModZ 1, 2, and 3.

b. Select the Channels you want to define as ModZ. Select ModZ 1,
ModZ 2, or ModZ 3. Leave as “None” those that you want to
remain as a normal PLS Channel. Click on the down arrow to
make your selections for Channel 1 through Channel 31. (Channel
32 is PLS only.)
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10. Under the Debounce Inputs tab you will click in the box in front of
Input 1, Input 2, Input 3, or Input 4 to select them if you want fast
debounce applied to that input.

System Attributes x|

General | ModZ Debounce Inputs |

Select the inputs for Fast debounce.
Deselect the inputs for normal debounce.

I Input1
™ Input 2
™ Input 3
[ lnput 4

aK I Cancel | Help |

11. Now you will set up communications. Click on Setup > Communica-
tions Setup. The following window will appear.

Communication Setup ﬂ

COM/Ethernet Port

Group and Unit Numbers ToM =

Group Number | -
- Ethemnet Details

Unit Mumber B! =
-2l I fddess
[hen connecting directly to the:

TPRLS card the Group and Unit Port Murnber T
number must each be set to 1] (10000 - 10939]

Help I (1] I Cancel I

12. Select the COM/Ethernet Port.

13. If you are connected to the Ethernet, enter the IP Address and Port
Number.

14. Click OK when finished to save settings, or click Cancel to exit
without saving.
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Click here to
configure a
program
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Create a Program in a TPRLS Project

You are now ready to begin creating a program within your TPRLS Project.
The number of programs that can be written within one project is only limited
by the available memory. For instance, a project with no speed compensa-
tion, a project name of three characters, and 32 channels with 1 set point per
channel can contain 588 programs. To configure a new program click on the
Add button as shown in the figure below.

A untitled - TPRLS

File View Setup Touch PRLS Online  Utiities Help

DEES 2% % Bx % e %lalfEkE
i~ Program
Prag # | MNarme | Scale Factar I Description

MAN-TPRLS-002

»  Add | Dielete |

The Add New Program # window will appear.

x|

Program Number

s

Description

Program Name

Speed Compensation Details

Scale Factor 360

Channel # | Dwell Type ‘Sp‘Comp on ‘Sp‘Comp Off I:

W e e e

Help I

Angle On Angle OfF ;I o o
angle On Angle OFF j 1]
Angle On Angle OFf j o
Angle On Angle OfF ;I o
angle On Angle OFF j 1]
Angle On Angle OFf j o
Angle On Angle OfF ;I i}
angle On Angle OFF j 1]
Angle On Angle OFf j o

EICICIAC I
|

Add New Program I Close |

1. Enter a Program Number and a Program Name. (You will not be
allowed to duplicate a Program number or name.)
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2. Enter a Description of the Program.

3. The Scale Factor that you have entered under System Attributes
for the project will be displayed. The Scale Factor will be the same for
all programs within a project. (It will be a value between 1 and 4096).

4. For Channel’s 1 through 32 select the Data Type. Choose from Angle
On/Angle Off, Angle On/Time Off (available only on Channels 1
through 8), or Speed Switch (available only on Channels 2 through
16.) You don’t have to use each channel.

5. Next you will enter Speed Compensation On and Speed
Compensation Off for Channels 1 through 16 that you program. (This
is only available for Channels 1 through 16.) (See page 10 for
explanation of Speed Compensation.)

6. Click on the Add New Program button when finished, or Close to quit

7. To add Set Points for a program, click on it to highlight in the top list
and the Set Points list (bottom) will become available for edit or
additions.

8. Click on the Add button at the bottom of the Set Points list. One of

the following three windows will open. They
=il  differ according to the data type you have

Program
’7 Mumber 1

Hame

selected for the Channel .

Program 1

Angle On/Angle
Off Data Type

Channel Number
' 5I
OM/OFF

Angle On < IU j J:;'[I 4
< o 4
ergen < i Bl

Program 4

Channel Number

Hop | [AddNew Setfar]

Close | ONAOFF

AngleOn < ID ﬂ
Angle P | Time [inmseo) <|1 ﬂ
On/Time Off
Data Type Heb | [Addnewseom] = Ciose | | boam3
rrannel Number
CONOFF———————————————
A [o
Speed Switch - ﬂ
Data Type P —I —I
oitren < | 2]
Help | AddNewSelenlI Close |
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10.

Click on one of these (<<
or >>) buttons to
increment or decrement
BOTH the ON and OFF
values by one

@ Please Note:

If the Angle On/Angle
Off “ON” and “OFF”
setpoints are equal,
that Setpoint will not be
executed by the
TPRLS. It will treat the
setpoint as if it did not
exist. However, it will
appear in the setpoint
lists.

MAN-TPRLS-002
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You will receive the following error message if you try to add more
than one setpoint per Channel that has an Angle On/Time Off or
Speed Switch Data Type. Only one Set Point is allowed per Channel
for those two data types.

T E

AN

Unable to add this setpoint.
Only one setpoink of type - Speed Switch allowed per channel.

If adding a setpoint, enter a Channel Number, and then enter the ON
value (Angle On or On RPM) and the Angle Off or Time Off (in
msecs), or OFF RPM.

5,
OMMAFF——————————

—
fngleOn < [ 1 7
< ad

Program
’VNumber 4
‘/
paal| [l //

Click on the < or > buttons
to increment or decrement
the ON or OFF value by
one

Mame:

Charinel Number

Program 4
Time [in msec] < I5D 3 I‘
Help | Apply Changes I

Close |

Click on the < or > arrow to increase or decrease the value by one
increment at a time. Click on the << or >> arrows between the two
value entry fields to increase or decrease BOTH ON/OFF fields by
one increment at a time.

S0 MSec
84

172

You can also change the values by clicking on the color bar in the
graph that represents it. Click and hold on the bar and drag it to the
new value. Click and hold a corner of the bar to change the value in
either direction (OFF value or ON value).
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11.

Moving the value on the
graph will also change
the value in the dialog
box and vice versa.

Edit SetPaint Details #3 i

MNamme Program 4

Program
’7 Murber 4

Chanrel Number (8

ONAOFF

Angle On € |24
<<
Angle OFf ;'85—

—fil
ol
—

UTICOR

| i

W angle o

Close I

Help | ADD\thangesI

To delete a set point from the list, click on it to highlight and then click

on the delete button. (To delete two or more, press and hold the shift
key while clicking on each set point row to highlight them. Click on
the Delete button and all highlighted setpoints will be deleted.

12 You can delete programs within the programs list in the same manner.
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«# | File Menu
Open... Chrl+0
Save s N ew

Save fs..,

Click on File > New if you want to close the current project and open a new
one. You will be asked if you want to save the current project.

Transfer Project to TRRLS
Read from TPRLS

Print... Ctri+P

Print Setup...

1 NPRLS Praject Lnpr Open
_Reexier | To open an existing project or to create a new project while in a programming
= window, click on File > Open. The window shown below will appear. Choose

from the available project files (*.npr). Click on Open to open the project, or
Cancel to quit without opening.

Laok i | 4 Touch PRLS x|« ®EeFE-
fi_Pm]ect 2.npr
File name: || l&l
Files of type: ITPHLS (“npr] j Cancel
2
Save
Save As...

Click on File > Save to save the current project. Project Attributes and setpoint
data bases will all be saved. Click on File> Save As... to save the current
project under another name.

Transfer Project to TPRLS

MAN-TPRLS-002

. rans 'er to Toudcl 2 X
This allows you to transfer the current i Sl =
(open) project to the TPRLS PowerPanel.

Click on Transfer Project to Touch PRLS Action —
and the dialog box shown to the right will Clicking Starl wil

open. This dialog box provides informa-
tion about transfer process and allows you
to check and/or change communication
parameters.

Press Start to begin the transfer or Can-
cel to abort.

1. Get Touch PRLS
2. Clear Memarm
3. System Attributes

4. User Program

. Restart

averwite the program
currently stared in the
Touch PRLS. If pou
do not wish to
overwiite the current
project click CAMCEL.

Then read the program
from the TPRLS and
save it to disk.

Help

Start Cancel |
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When the transfer is in process, a x|
progress bar will indicate will indicate the

transfer status. It may take a minute or

two to complete the transfer. You will be Acton R
g s Clicking 5 ill
notified when it is complete. S Touh LS Seheie o
currently stored in the
Touch PRLS. If pou
do not wish to

aversiite the curment
praject click CAMCEL.

e

Clear Memary

If you receive an error message, shown
below, you will need to check your
TPRLS to PC connections.

=}

System attibutes

Then read the program
from the TPRLS and
Restart save it to disk.

s

User Fragram

.

TPRLS x| Getting Touch PRLS Information...
Help | Start | Cancel |
& Errar in getting Touch PRLS Infarmation.

Communication Setup

Click on the Communication Setup button. Click on the down arrow under
COM/Ethernet Port to select the correct PC Port —COM1, COM2, COM3, or
COM4. When connected directly to the TPRLS option card in the panel, you
will need to set the Group Number and Unit Number to One. If you are con-
nected to the Touch PRLS panel’s COM port, enter the appropriate numbers
for that panel. If you select Ethernet, the Ethernet Details dialog will become
available. Enter the IP Address and Port Number for the Touch PRLS.

Communication Setup 5[

COM/Ethermet Port
Group and Unit Humbers

COM1 ~
Group Mumber  {F] -
= Ethemet Details——————————————
Uniit Nurnber |1 _Izjl ’VIF o li
ress < = 5

[when connecting directly to the: ity
ot Humber
{10000 - 10358) ffoac

TPRLS card the Group and Unit
Help | akK I Cancel |

number must each be set to 1]

Read from Touch PRLS =

If you are connected to a Touch PRLS and want
to transfer a project from the unit to your TPRLS
Programming Software for editing, click on Read
from TPRLS.

= |f you have an open

& Save changes to Project 1.npr? pr‘OjeCt, yOU W|" be
asked if you want to

Yes kMo | Cancel |

Cammunication Setup

1. Get TPRLS Information
2. Swstem Attibutes

Action

3. User Fragram

Help Start Cancel

save changes. Your

current project will

MAN-TPRLS-002
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v Toolbar
v Status Bar
v SetPoint Yalues
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close and a new, untitled, project will open. The project you are reading from
the TPRLS will be written to the new project. Be sure to name and save the
project. Any changes you make to the project will not take effect until you write
the edited project to your TPRLS.

Click on the Start button to start reading the project from the TPRLS. A progress
bar will appear letting you know the status of the transfer.

When the program has been read from TPRLS, click OK. (If you receive an
error message, click on the Communication Setup button and check that the
PC Port, Group Number, and Unit Number match the settings of the TPRLS
that you are trying to communicate with.)

Print
Click on Print to print the entire project (All e A
programs), or select a program number from Select Program——————————
. . & All programs
the project to print. You can also choose lrrpm;a?nnumhel =]

whether or not to print the System Attributes
and the bar graph of the set points (Graph-
ics). Click in the box in front of the items that
you want to print to select them. Hep | [P | Caneal

IV System attributes
¥ Graphics

Print Setup
Choose or change your print settings here.

“Recent Project”
Here you will find listed the most recent projects opened for editing. Up to four
projects may be listed. You can click on them in this list to open.

Exit
Click here to close all projects and exit the Touch PRLS Programming Soft-
ware.

View Menu

Toolbar

The toolbar provides shortcuts to some of the main menu functions and com-
mands. The toolbar is visible by default. If you do not want the toolbar to
appear on the main programming screen, click on it in the menu to remove the
checkmark.

Status Bar

This is also selected by default. If you do not want the status bar display at the
bottom of the main programming screen, click on it and remove the check
mark.
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Setup

Project Information. ..

System Attributes. ..

Communication Setup...

General

32

SetPoint Values

Setpoint values appear along the bar graphs on the right hand side of the
screen. If you do not want the actual numerical values to appear, click on this
menu item to remove the checkmark.

Setup Menu

Project Information
Click on Project Information and the window ]
shown to the right will appear. You can then
enter or edit information about the current |
project. Enter the location (Plant) where the | M= !
program will be used. You may enteraname |*® !

Plant

for the Machine and the Job for which the = |Femmerts -
program applies. Also you may enter up to i
200 characters in the Comments field. Concel

System Attributes

Click on System Attributes and the window shown below will appear. System
Attributes allow you to program parameters common to all programs within a
project and specific to the machine for which the project is created.

system Attributes x|

Gereral | ModZ I Diebounce Inpulsl

Machine Offsat g Scale Factor 20

Direction
’V % Clockwise ™ Counterclockwise

Ok I Cancel I Help I

Under the General tab you will enter the Machine Offset and Scale Factor for
the resolver-based machine that the project is being created for. Select Clock-
wise or Counterclockwise depending upon the direction that the resolver will
revolve.
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ModZ

NOTE: Channels 1-
31 can be MODZ or
PLS. Channel 32 is
PLS only.

Debounce
Inputs

MAN-TPRLS-002
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System Attributes x|

General ModZ |Dsbuuncs\nputs|

lgnore ModZ (1] for IU— scale counts lgrore kMod= (3] for IU— soale counts
lgnore Mod? (2] for IU— scale counts

Chit 1 IpLS j Chit9 IpLS j DhuWIPLS j Chit 25 IPLS j
Chit2 IpLB j Chit 10 IpLB j EhtHEIpLS j Chit 26 IpLS j
Chit3 IpLB j Chit 11 IpLB j EhtHSIpLS j Chit 27 IpLS j
Chit 4 IpLB j Chit 12 IpLB j EhﬂZUIpLS j Chit 28 IpLS j
Chit§ IpLS j Chit 13 IpLS j Chit 21 IPLS j Chit 23 IPLS j
ChitB IpLS j Chit 14 IpLS j EhﬂEEIPLS j Chit 30 IPLS j
Chit 7 IpLB j Chit 15 IpLB j ChﬂEEIpLS j Chitt 31 IpLS j
Chitg IpLS j Chit 16 IpLS j ChﬂEdIPLS j Chit 32 IPLS j

(1] I Cancel I Help I

Under the ModZ tab you will enter the following parameters. Modification to
Zero (ModZ) enables you to modify the zero reference point independent of
the resolver’s actual position.

First you will enter the number of Scale Counts (between 0 and 4096, de-
pending on the scale factor) that you want ModZ (1) Input to be ignored for.
This is also referred to as the Inhibit Zone. Repeat for ModZ (2) and ModZ (3).

For each channel (see note to the left) you will select the ModZ(1), ModZ(2),
ModZ(3) scale count inhibit (ignore) zone, or PLS. If you select PLS, the
Channel functions as a programmable limit switch (PLS).

system Attributes x|

General | Modz  Debounce Inputs |

Select the inputs for fast debounce.
Deselect the inputs for nomal debounce.

™ Input1
I Input 2
™ Input 3
™ Input 4

oK I Cancel I Help I

Click on the Debounce Inputs tab to program Inputs 1 through 4 for fast or
normal debounce. If you place a check mark in the box in front of Input 1,
Input 2, Input 3 (all ModZ) or Input 4 (Program Enable) you will program them
as fast debounce. If not selected the inputs will be read as “normal” debounce.
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Touch PRLS

Information...
Clear Memory

Upgrade Firmware. ..

34

Touch PRLS Menu

Information

Click on this menu item when you are connected to a Touch PRLS and you will
receive information about the TPRLS that you are connected to. Information
will include:

Device Type: Encoder
Memory
Exec: Amount of memory available to IS =
hold the boot and exec firmware. Bl B
User Memory: This is the total RAM e s || AC
memory available for use in the TPRLS. e
Revision
Boot: This is the revision of internal FurmngFam g
panel firmware used to power-up (boot) b |
the panel.
Exec: This is also internal panel firm-
ware, used to display panel information
and allow panel adjustments to the in-
ternal clock, contrast adjustment, and
testing of the panel touch cells and dis-
play.
Hardware: (0 = first revision) This is the
revision of the Touch PRLS.

Clear Memory

Click here to Clear the current user program from the Flash Memory in the
TPRLS.

Upgrade Firmware (SEE CAUTION, BELOW)

There may be occasional upgrades to the TPRLS internal software, also re-
ferred to as the Exec or Firmware. (Check the www.uticor.net website peri-
odically for information about software and firmware upgrades.)

Caution: Upgrading Firmware will clear the current user program in the
TPRLS. You must save the user program to disk and then transfer it
back to the TPRLS after the upgrade.

MAN-TPRLS-002
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To Upgrade Firmware:

1.

MAN-TPRLS-002

Back up the user program currently stored in the TPRLS and save to
disk.

Click on Upgrade Firmware, the window below will appear.
x|

Firmyvare file to send to TPRLS

File Revision Select Firmware fie... |

TPRLS Revision

Press Upload to continue

lipoecl | Cancel |

Click on Select Firmware file button and navigate to the new firm-
ware file (.hex file). Firmware is generally stored in the TPRLS Pro-
gram file, in the “Project” folder. Click on the .hex file that you want to
import and click on the Open button.

21|
Look in: Ia Project j - £k E-
File name: [ hex] e I
Files of type: |TPHL5 Firmware files(*_hex) =l Cancel
4

The dialog box will show the File Revision number of the firmware
and the TPRLS Revision of the Firmware. Check these revision num-
bers. If they are the same (no upgrade is needed) you may click on
the Cancel button to exit.

Select the appropriate COM port under Ethernet/COM Port and click

on the OK button to begin the upgrade. A status bar will let you know
when the upgrade is complete.
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Online

AutoZero Machine Offset...
Read InputfOutput Status. ..
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Online Menu

AutoZero Machine Offset

Click on AutoZero Machine Offset if you want the program
loader to read the current offset online and set the machine
resolver to this value. You will receive the message to the
right that will show you what the offset value is.

Read Input/Output Status
Click on Read Input/Output Status to visually monitor the input and output
status of the TPRLS. The following dialog will appear.

Read Input / Dutput Status x|

Position 0 RPH 0 Zeio Offsst 273

Input
( Input 1 Itz @ 3 @ nptd @

Output
Channel 1 Channel 3

Channel 2 Channel 10
Channel 3 Channel 11

o]

Q Channel 17 @  Channel 25 @
o]

o]

Channel4 @  Channel 12

L]

L ]

o]

o]

Channel 18 @ Chamnel 25 @
Channel 19 @ Channel 27 @
Channel 20 @ Channel 28 @
Channel 2! @ Channel 23 @
Channel 22 @ Charnel 30 @
Channel 23 @ Channel 31 @
Channel24 @  Channel 32 @

Channel 5 Channel 13
Channel § Channel 14
Channel 7

Channel 8

Channel 15
Charinel 16

L]
L)
L]
@
o
L]
°
o]

(L”"“ O o @ o |

Help StatMonioing_ | Retresh cose |

Click on the Start Monitoring button to begin reading the status of the TPRLS
inputs and outputs.

At the top of the window is shown the Position, RPM, and Zero Offset of the
machine resolver. Below that the Input Status for Input 1, Input 2, Input 3,
and Input 4 is shown. A green indicator next to the input shows that the input
is ON. Ared indicator shows that it is OFF.

The Output Status for each Channel (1 through 32) is also shown by either a
green (ON) or a red (OFF) indicator.

Click on the Refresh button to get a new read of the status. Click on Close to
end the monitoring.
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Ukilities

Export Project  »
Import Project »
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Touch PRLS™

Utilities Menu

Export Project

Click here of you want to Export Project data. Open the Project, then click on
Export Project> To Excel, or To CSV Format. Please be aware that the
System Attributes will not be exported, only the Program data.

Click on the Export Project menu item to write the
project data (except system attributes) from your cur-
rent (open) project to an Excel file or a CSV file.

Ukilities
roject »

Import Project »

To C3Y F%at |

To Excel

Click on the To Excel menu item to write the programs from your current (se-
lected) program to a Microsoft Excel® file. The TPRLS Programming Software
will open Microsoft Excel and write the project to an Excel book as shown
below. Click on File >Save As in the Excel program and enter a name for the
file. Click on the Save button to save the file under the name you have entered.
Close Excel to return to TPRLS Programming Software.

J File Edt Yiew Insett Format Tools Data Window Help
DeHa aRY|imB I o-a-
Al j =‘ PROGRAM _HEADER_INFO

- 10 -

" N0 A 1 §¢|ﬂ|_100% = @,H.ﬁma\

A | B [ © [ D E
FROGRAM HEADER INFO IProgram # 1
FROGRAM_HEADER_INFO Program Mame Prograrm 1
PROGRAM_HEADER_INFO Program Description This is program 1
FROGRAM_HEADER_INFO Scale Factor 360
FROGRAM_HEADER_INFO Channel # Dweell Type Speed Comp On Speed Comp Off
PROGRAM_SPEEDCOMP_IMNFO 1 Angle On Angle Off 24 0
FROGRAM_SPEEDCOMP_INFO Angle On Angle Of o ]

PROGRAM_SPEEDCOMP_INFO
PROGRAM _SPEEDCOMP_INFO
PROGRAM_SPEEDCOMP_INFO
PROGRAM_SPEEDCOMP_INFO
PROGRAM_SPEEDCOMP_INFO
PROGRAM_SPEEDCOMP_INFO
PROGRAM _SPEEDCOMP_INFO 9
PROGRAM_SPEEDCOMP_INFO 10
PROGRAM_SPEEDCOMP_INFO 1
PROGRAM _SPEEDCOMP_INFO 12
PROGRAM_SPEEDCOMP_INFO 13
PROGRAM_SPEEDCOMP_INFO 14

Angle On Angle Off
Angle On Angle Of
Angle On Angle Off
Angle On Angle Off
Angle On Angle Off
Angle On Angle Off
Angle On Angle Of
Angle On Angle Off
Angle On Angle Off
Angle On Angle Of
Angle On Angle Off
Angle On Angle Off

\m|b|w‘M|A‘D|m|m|w|m‘m|b|m‘m =
IR N

@
oooocooooocooooo
ooooooooooooogo

FROGRAM_SPEEDCOMP_INFO 15 Angle On Angle Of
PROGRAM_SPEEDCOMP_INFOD 16 Angle On Angle Off
EMND OF SETPOINTS FOR 1 Program 1
FROGRAM_HEADER_INFO Program # 2
FROGRAM_HEADER_INFO Program Mame Program 2

PROGRAM_HEADER_INFO
PROGRAM HEADER_INFO
PROGRAM_HEADER_INFO

Program Description This is program 2
Scale Factor 360
Channel # Dweell Type

Speed Comp On Speed Comp Off

L e
00|~ | 0| th| £ | )| kD | = | o o |~

PROGRAM_SPEEDCOMP_INFO 1 Angle On Angle Off 0 45
| 29 |PROGRAM_SPEEDCOMP_INFO 2 Angle On Time Off 25 30
30 |PROGRAM SPEEDCOMP INFO 3 Speed Swi_ S ———
51
A message W|” appear |ett|ng yOU knOW & Successfully exported 114 setpoints to Excel file,

whether or not the write was successful
and the number of setpoints that were
written to the file.
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To CSV Format

UTICOR

The CSV (Comma delimited or Comma-separated values) file format saves
only the text and values as they are displayed in cells of the project. All rows
and all characters in each cell are saved. Columns of data are separated by
commas, and each row of data ends in a carriage return. If a cell contains a
comma, the cell contents are enclosed in double quotation marks.

To Excel
Import Project ¥

PROGRAM_HEADER_INFO,Program #,1

Example of what a CSV file looks like opened in Notepad:

PROGRAM_HEADER_INFO, Program Name,Program 1
PROGRAM_HEADER_INFO,Program Description,This is program 1

PROGRAM_HEADER_INFO,Scale Factor

,360

PROGRAM_HEADER_INFO, Channel #,Dwell Type,Speed Comp On,Speed Comp Off

PROGRAM_SPEEDCOMP_INFO,1,Angle O
PROGRAM_SPEEDCOMP_INFO, 2,Angle Ol
PROGRAM_SPEEDCOMP_INFO, 3,Angle Ol
PROGRAM_SPEEDCOMP_INFO,4,Angle Ol
PROGRAM_SPEEDCOMP_INFO, 5,Angle Ol
PROGRAM_SPEEDCOMP_INFO,6,Angle Ol
PROGRAM_SPEEDCOMP_INFO,7,Angle Ol
PROGRAM_SPEEDCOMP_INFO, 8,Angle O
PROGRAM_SPEEDCOMP_INFO0,9,Angle O
PROGRAM_SPEEDCOMP_INFO,10,Angle
PROGRAM_SPEEDCOMP_INFO,11,Angle
PROGRAM_SPEEDCOMP_INFO,12,Angle
PROGRAM_SPEEDCOMP_INFO,13,Angle
PROGRAM_SPEEDCOMP_INFO, 14,Angle
PROGRAM_SPEEDCOMP_INFO,15,Angle
PROGRAM_SPEEDCOMP_INFO,16,Angle
END OF SETPOINTS FOR,1,Program 1
PROGRAM_HEADER_INFO,Program #,2

n Angle
n Angle
n Angle
n Angle
n Angle
n Angle
n Angle
n Angle
n Angle
on Angle
on Angle
on Angle
on Angle
on Angle
on Angle
on Angle

off,24,30
off,0,0
off,0,0
off,0,0
off,0,0
off,0,0
off,0,0
off,0,0
off,0,0

PROGRAM_HEADER_INFO, Program Name,Program 2
PROGRAM_HEADER_INFO,Program Description,This is program 2

PROGRAM_HEADER_INFO,Scale Factor

,360

PROGRAM_HEADER_INFO, Channel #,Dwell Type,Speed Comp On,Speed Comp Off
PROGRAM_SPEEDCOMP_INFO,1,Angle On Angle 0Off,0,45
PROGRAM_SPEEDCOMP_INFO,2,Angle on Time 0off,25,30
PROGRAM_SPEEDCOMP_INFO, 3, Speed Switch,25,125
PROGRAM_SPEEDCOMP_INFO,4,Angle On Angle 0off,0,0

Click on To CSV Format if you
want to save the project data as
a .CSV file. The window shown
to the right will appear allowing
you to name the file and navigate
to the directory and folder where
you want to save it.

x

& Successfully exported programs to :\Pragram Files!, Touch PRLS\Praject 1 data.csw.

21|
Save i |13 Touch FRLS T = ®EcrE-

Project 1 daka.csw

File narne:

Save as lype:

Iﬁ Save I
ITnuch PRLS project C5V Files [*.cav] j Cancel D
7
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Import Project

Click on one Program in your project’s program list to highlight it, and then
click on the Import Setpoints menu item to import Messages into your current
(open) project from a Microsoft Excel® (.xls) file or a CSV (Comma delimited or
Comma-separated values) file format. Please be aware that only the Pro-
gram data can be imported, system attributes CANNOT be imported, you
will have to enter them under the Setup menu.

From Excel
1. Click on the Import Project > From Excel menu item to select the
Microsoft Excel® file where the Excel file resides. The following Read
Touch PRLS Excel File window will appear. Navigate to the file you
want, click on it to highlight it and then click on the Open button.

Read Touch PRLS Excel File j 2l
Laok in: Ia Marta ﬂ = £ BB
Project 1 setpoinks. xls
File: name: lﬁ Open I
Files of ype: ITnuch PRLS program(s] Ewoel Files [* #ls) j Cancel |
P

2. The file will be written to a new project. If you have a project open,
that project will automatically close when you import the Excel file.
This is to prevent you from overwriting an existing project unintention-
ally. Make sure to give your project a name and save it right away.

3. Set the Project Attributes for the imported project. Click on Setup >
Project Attributes.

4. The imported project programs will now be listed in the upper left list
on the main programming screen. To view the setpoints, click on a
program in this list and they will be displayed in the Setpoint List on
the bottom left.

MAN-TPRLS-002 39
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From CSV Format

1. Click on Import Setpoints > From CSV Format to import setpoints
from a .CSV file. The following window will appear. Navigate to the
folder where the file is stored.

Read program(s) C5¥ File 2l
Lnnkm'l@Marta j - oF -
Project 1 setpaints.csy
File namme: [ o] Open I
Files of ype: ITnuch PRLS program(s] CSY Files [* cav] j Cancel |
P

2. Click on the .csv file you want to import to highlight it and then click on
the Open button. The comma separated values in the .csv file will be
imported into a new project. If you have a project open, it will auto-
matically close when you import the data file. This is to ensure that
you don’t inadvertently overwrite an existing file. Be sure to name
and save the imported project right away.

3. Enter the System Attributes for the imported project. Click on Setup >
System Attributes and save the project.
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Help

Help Topics

About TPRLS. ..

MAN-TPRLS-002

Touch PRLS™

Help Menu

Help Topics
Click here to access the online Help Topics for the Touch PRLS.

About TPRLS

Click on About TPRLS to access the following window. It provides you with
information about the current version of the software. To help us answer your
questions effectively, please make sure that you know the current version of
the software before calling Technical Support.

x
Touch PRLS Yersion 1.0

Copyright [C) 2003
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Add
Edit
Delete

Copy
Paste

UTICOR

Right Click Menu

The Right Click Edit Menu will appear when you click your right mouse button
while in the list of programs or list of channel setpoints in the Main Program-
ming Screen.

From this popup menu you can:

.

Add a new program or setpoint (brings up the Add New Program, or
Add New Setpoint window depending upon whether you have
selected a program in the Program List or a Setpoint in the Setpoint
list)

Edit a program or setpoint (brings up the Edit Program or Edit
Setpont window)

Delete one or more programs or setpoints

Copy one or more programs or setpoints

Paste copied programs or setpoints to new locations in the project
or program. You will select the Program or Channel Setpoints in
either list by clicking on one or more to highlight. See below.

Paste Program
If you want to duplicate a program or programs in the project, perform the
following steps:

1.

Click on the program in the list to high-
“ ht |t Source Program # 1
g ) Source Program Program 1
Mame
Right click your mouse anywhere in the Desination Frogram =
main programming screen. The right L
click edit menu will appear. e

Help I akK I Cancel |

Click on Copy in the menu.

Click on Paste in the menu and the paste program window will ap-
pear.

The Source Program number and the Source Program Name will
be displayed at the top of the dialog box.

Select the Destination Program number and the Destination Pro-
gram Name of the new “pasted” program. Please note that you will
not be allowed to paste over an existing program. You must select an
unused program number and name.

Click OK when finished.

MAN-TPRLS-002
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Touch PRLS™

Paste Setpoints

If you want to copy programmed setpoints from one channel to another chan-
nel, perform the following steps:

1.

Click on the Source Channel or Channels that you want to copy in
the Setpoint list in the bottom left of your main programming screen.
(Remember that you only Channels 1 through 8 can be programmed
as Angle On/Time Off setpoints.)

Right click your mouse and then click on Copy in the popup menu.

Now right click again and click on Paste in the popup menu. The
following window will appear.

Paste Setpoints J 5[

Source Channel # 1

Deestination Channel # =

Help I oK I Cancel I

Choose the Destination Channel for the first Source Channel you
have selected. Click OK. The Paste Setpoints window will continue
to appear until all Source Channel setpoints that you have copied
have been pasted to their Destination Channels.
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Touch PRLS Registers — Types and Sets

CHANNEL_TO_FINETUNE
This allows you to specify the output channel that you want to finetune.

SETPOINTS_TO_FINETUNE
This allows you to specify the setpoint within the channel to finetune.
Putting a 0 in this register will finetune all setpoints in that channel.

FINETUNE

When this register contains a value of 1, the ON setpoint is changed.

When this register contains a value of 2, the OFF setpoint is changed.

When this register contains a value of 3, the ON & OFF setpoints are changed.

FINETUNE_INCREMENT
Set this bit to increment the selected setpoint(s).

FINETUNE_DECREMENT
Set this bit to decrement the selected setpoint(s).

MODZ_INPNUM_FOR_CHANNEL_1 (1-32)
Assign MODZ input (1, 2 or 3) to this channel.

CHANNEL_1_TYPE (1-32)

When this register contains a value of 0, this channel is Angle ON Angle OFF.
When this register contains a value of 1, this channel is Velocity.

When this register contains a value of 2, this channel is Angle ON Time OFF.

When this register contains a value of 3, all setpoints in this channel will be cleared.

CH1_ON_SPEEDCOMP (1-16)
This value is the on time speed compensation in Msec (-4095 to 4095) for this channel.

CH16_OFF_SPEEDCOMP (1-16)
This value is the off time speed compensation in Msec (-4095 to 4095) for this channel.

MODZ_INP1_IGNORE_COUNTS (1-3)
This value is the number of counts the MODZ input will wait until it can be re-triggered.

PROGRAM_MODIFIED
Bit 0 of this register is set if a setpoint or channel type has been modified.

UPDATE_SETPOINTS

Setting this discrete to a 1 will update the user program with the current setpoint data
(after updating set this value to 0).

MAN-TPRLS-002 A-1
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Touch PRLS Registers — Types and Sets (Continued)

CH_1_SP_1_ON
This register contains the ON value for Channel 1 Setpoint 1.

CH_32_SP_4_OFF
This register contains the off value for Channel 32 Setpoint 4.

A-2 MAN-TPRLS-002
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